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Welcome to R:Archive X.5 Enterprise!

R:Archive is a powerful document archival management system
that allows users to automatically, or manually, scan documents
into PDF documents using a scanner.

After a document is scanned, R:Archive allows users to alter the
PDF document properties to allow extended search capabilities in
the future.

R:Archive also allows users to search and index PDF documents
available to the computer. Once the documents are indexed, the
user can easily review the PDF document information and preview
the actual file.
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1 Introduction

1.1 Introducing R:Archive X.5 Enterprise

R:Archive is a powerful document archival management system that allows users to automatically, or
manually, scan documents into PDF documents using a scanner. After a document is scanned, R:Archive
allows users to alter the PDF document properties to allow extended search capabilities in the future.

R:Archive also allows users to search and index single or multiple PDF documents available to the
computer. Once the documents are indexed, the user can easily review the PDF document information
and preview the actual file.

The R:Archive application offers extended search capabilities to search all scanned and indexed PDF
documents. The search criteria for scanned files allow users to define the date, operator, or title. The
search criteria for indexed files allow users to define the date, operator, title, subject, author, or
keyword. 

A report catalog is available for all documents scanned, PDF files documents indexed, and document
management sessions.

R:Archive includes database maintenance to keep a system running smoothly. A table analysis can be
performed on each table, and if required, users can pack the table. Additional maintenance includes
packing the indexes and a database backup routine. Users can even review the User Access and Session
Log Tables. 

1.2 Copyrights

Information in this document, including URL and other Internet web site references, is subject to change
without notice. The example companies, individuals, products, organizations and events depicted herein
are completely fictitious. Any similarity to a company, individual, product, organization or event is
completely unintentional. R:BASE Technologies, Inc. shall not be liable for errors contained herein or for
incidental consequential damages in connection with the furnishing, performance, or use of this material.
This document contains proprietary information, which is protected by copyright. Complying with all
applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted
in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any
purpose, without the express written consent of R:BASE Technologies, Inc. We reserve the right to make
changes from time to time in the contents hereof without obligation to notify any person of such revision
or changes. We also reserve the right to change the specification without notice and may therefore not
coincide with the contents of this document. The manufacturer assumes no responsibilities with regard to
the performance or use of third party products.

Products that are referred to in this document may be either trademarks and/or registered trademarks of
the respective owners. The publisher and the author make no claim to these trademarks.

The software described in this document is furnished under a license agreement. The software may be
used or copied only in accordance with the terms of that agreement. Any unauthorized use or duplication
of the software is forbidden.

R:BASE Technologies, Inc. may have patents, patent applications, trademarks, copyrights, or other
intellectual property rights covering subject matter in this document. Except as expressly provided in any
written license agreement from R:BASE Technologies, Inc., the furnishing of this document does not give
you any license to these patents, trademarks, copyrights, or other intellectual property.

Trademarks

R:BASE®, Oterro®, RBAdmin®, R:Scope®, R:WEB Suite®, R:Mail®, R:Charts®, R:Spell Checker®,
R:Docs®, R:BASE Editor®, R:Scheduler®, R:BASE Plugin Power Pack®, R:Style®, R:Code®, R:Struc®,
RBZip®, R:Fax®, R:QBDataDirect®, R:QBSynchronizer®, R:QBDBExtractor®, R:Mail Editor®,
R:Linux®, R:BASE Dependency Viewer®, R:Archive®, R:Chat®, RDCC Client®, R:Mail Editor®,
R:Code®, R:Column Analyzer®, R:DF Form Filler®, R:FTPClient®, R:SFTPClient®, RBMap®,
R:GeoCoder®, R:PDF Form Filler®, R:PDFWorks®, R:PDFMerge®, R:PDFSearch®, RBInstaller®,
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RBUpdater®, R:Capture®, R:RemoteControl®, R:Synchronizer®, R:Biometric®, R:CAD Viewer®,
R:DXF®, R:Twain2PDF®, R:Tango®, R:SureShip®, R:BASE Total Backup®, R:Scribbler®, R:SmartSig®,
R:OutLink®, R:HASH®, R:JobTrack®, R:TimeTrack®, R:Syntax®, R:WatchDog®, R:Manufacturing®,
R:Merge®, R:Documenter®, R:Magellan®, R:WEB Reports®, R:WEB Gateway®, R:Stat®,
R:ReadyRoute®, R:Accounting®, R:Contact®, R:DWF Viewer®, R:AmazonS3®, R:Mail Viewer®,
R:Java®, R:PHP® and Pocket R:BASE® are trademarks or registered trademarks of R:BASE
Technologies, Inc. All Rights Reserved. All other brand, product names, company names and logos are
trademarks or registered trademarks of their respective companies.

Windows, Windows 10, Windows 8.x, Windows 7, Vista, Windows Server 2008-2019, Bing Maps,
MapPoint, and Outlook are registered trademarks of Microsoft Corporation.

Printed:  April  2021 in Murrysville, PA

First Edition

1.3 License

R:BASE TECHNOLOGIES, INC. LICENSE AGREEMENT 
 

R:Archive X.5 Enterprise
Single Site License 

 
This is a legal agreement between you, the end user ("Licensee"), and R:BASE Technologies, Inc.
("RBTI"). Opening this package indicates your agreement with all of the following. If you do not accept
the terms of this binding agreement, DO NOT BREAK THE SEAL ON THE DISK PACKAGE. Your money will
be refunded upon the return of the unopened product directly to RBTI, or to the authorized developer
from which you acquired this package, with proof of purchase, and in compliance with the 30 day return
period described in the LIMITED WARRANTY below.

LICENSE 
This RBTI License Agreement permits you to use one copy of the R:Archive computer software with
associated utilities  (the "Program") and accompanying user documentation (the "Documentation") on
any single computer provided the Program is being used on only one computer at a time. (The R:Archive
5 Seat Add-On License permits additional seats ton any computer provided the Program is being used
within a single physical location. A Program is "being used" on a computer when it is loaded into a
temporary memory or installed on a hard drive in the computer. However, a copy of the Program
installed on a network server for the sole purpose of distribution to other computers is not "being used".
Each seat having access to the Program must have an appropriate license.

5 SEAT ADD-ON AND SITE LICENSES 
If a printed or other form of “hard-copy” License accompanied the copy of the Program you received
whose terms vary from this agreement, then the hard-copy License governs your use of the Program. 5
Seat Add-On and Site Licenses allow you to install the Program on the total number of machines for
which you are licensed only.

COPYRIGHT AND RESTRICTIONS 
RBTI retains full ownership rights in the Program and Documentation. You may make a single copy of the
Program; to be used solely for backup or archival purposes, or you may transfer the Program onto a
single hard disk provided you keep the original solely for backup or archival purposes. Such copies shall
be owned by RBTI. You may not copy any printed material or Documentation without prior permission.
You may not decompile, disassemble, cross-compile, reverse engineer, or make or distribute any other
form of, or derivative work from, the Program. You may not obscure, alter or remove any RBTI
copyright, trademark or proprietary rights notices.

TRANSFER OF LICENSE
You may not lend, rent or lease the Program or Documentation or any copies to any person. A transfer
of license is only authorized through completion of the Consent to Assignment and Assumption of
Contract agreement from RBTI. Upon license transfer, you are permanently giving such person
possession of all copies of the Program and Documentation, are permanently giving up your right to use
the Program and Documentation, and the recipient agrees to the terms of this License Agreement. 
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STEP UPS AND UPGRADE PURCHASES
As the Licensee, you are authorized to use the Program only if you are an authorized user of a qualifying
product as determined by RBTI. Upon installation, the new license agreement takes the place of the
agreement of the qualifying software you stepped up or upgraded from. After you upgrade, you may no
longer use the software from which you upgraded. When you install the upgrade, you must uninstall the
copy of the qualifying product.

TERM OF LICENSE 
The licensing provided in this License Agreement is perpetual unless you violate any of its terms or
conditions, at which time the license will automatically terminate. Upon termination you must return all
copies of the Program and Documentation to RBTI or certify in writing to RBTI that all such copies have
been destroyed and uninstalled from each workstation and/or network server. RBTI reserves the right to,
at its expense and without prior notice, conduct periodic inspections for licensing compliancy. If licensee
is found to be in violation of current agreement, RBTI may commence a civil action seeking fines,
damages, attorney fees and injunctive relief and may also, in appropriate circumstances, seek criminal
prosecution.

ACTIVATION CODES
The Program requires activation using a unique code. If you purchase a Single Seat License with or
without 5 Seat Add-On Licenses, you agree to comply with the license activation and verification
procedure described in this section of the Agreement. The activation technology may prevent your use of
the Program if you do not follow the activation process described in this Agreement. 

Each activation code is tied to one Windows operating system computer. A dual-boot computer with
multiple operating systems cannot activate a Single Seat License on more than one operating system.
Any software utilities which alter how the Program is installed on a local drive are not supported. This
includes any utilities which alter, remove or transfer the location of the Program on the hard drive, or
any hard drive utilities which alter the physical properties of the local drive.

The Program activation can be completed automatically through an Internet connection, manually
through a provided email option, or by calling our office between 10:00am and 6:00pm Eastern Time at
1+724-733-0053. In doing so, the Program Registration Number and Computer ID must be provided.
License validation allows a number of activations based upon the number of licenses purchased.

An Seat may be moved from an old computer to a new one that replaces it, as long as the Program is
not reused again on the old computer. Moving a Seat to another computer requires license re-activation,
which cannot be performed more than once within thirty (30) days. Conditions for transferring the
Program to another computer are applicable within 1 YEAR of your software purchase, or depend on your
active Software Assurance Plan status.

If a computer is no longer using R:BASE, through license transfer or hardware failure, the Activation Key
that was used on that computer must be submitted to R:BASE Technologies so we can then remove the
Activation Key from our log. We will disable the Key, which will then free up that used activation. Once a
key is reported to us as no longer in use and deactivated, it can no longer be used on that computer.
Product deactivation can be performed automatically from within R:BASE. To review the License Key and
Activation Key product information, select "Help" > "Product Activation" from the Menu Bar.

Licenses for the Corporate VIP Licenses of the Program are not controlled by activation codes and can be
operated from computers that are not connected to the Internet.

LIMITED WARRANTY 
RBTI warrants to you, as the initial user, that for a period of thirty (30) days from your receipt of the
Program and Documentation, 1) the Program will perform substantially in accordance with the
Documentation, provided it is used in unaltered form with functioning equipment and operating systems
for which it was designed; and 2) the CDs, and any accompanying hardware shall be free from defects in
materials and workmanship, under normal use and service. RBTI will, at its option, replace defective
CD’s or hardware or correct substantial program errors at no charge, provided you return defective
items to RBTI with proof of payment WITHIN 30 DAYS of your acquisition of this package. Unopened
product may be returned within 30 days for a full refund, minus shipping and handling charges. These
are your sole remedies for any breach of warranty. No exceptions will be made.

SERVICES PROVIDED WITH PURCHASE
 
1. 30-Day Limited Complimentary Technical Support 
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LICENSEE RESPONSIBILITIES
 

· To help us expedite the process and provide high quality assistance, the licensee must provide
proof of purchase when calling. Proof of purchase is defined as the following: registration
number, purchase date, version and build number, and company or individual to which product
is registered.

· To have operating system, workstations, and local network installed and functional. RBTI will
NOT be responsible for resolving issues not pertaining to the Program.

· Our support staff deals with advanced issues, therefore the person contacting RBTI for
assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

· To have the database(s) being converted, safely backed-up before attempting conversion
process.  RBTI will NOT be held responsible for lost data or corruption as a result of advice
given.

· Once converted, Licensee is responsible for updating command syntax in application, altering
forms and report to accommodate the 4-digit year function, and other changes as necessary.

R:BASE TECHNOLOGIES, INC.  RESPONSIBILITIES
· To provide quality assistance in a timely manner to aid Licensee in the installation of the

product within 30 days of the date of purchase.
· To provide a reasonable solution for any resolvable issue.  Not all issues are resolvable, and

therefore we will acknowledge the existence of known issues or “bugs” which we are presently
aware of, that have no reasonable work-around.

RBTI reserves the right to limit the amount of support time allotted to a maximum of 2 HOURS
during the 30-Day Complimentary Technical Support Period.  We also reserve the right to limit
the quantity of calls from a particular Licensee to 30 MINUTES in a single day.  Issues are dealt
with on a case-by-case basis, and are handled at the discretion of the support agent assigned to
the case.

Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related
issues ONLY. Our support hours are from 10am. to 6pm. Eastern Time.

For assistance on your APPLICATIONS, DESIGN, or ADVANCED CONVERSION issues, we offer
Technical Support Plans of various types to meet your needs.  Please call us at 1+724-733-0053
or visit the SUPPORT area of our website at http://www.rbase.com for details and pricing.

2. Fixes For Known Issues

RBTI will provide continued product fixes for known issues or “bugs” for 1 YEAR from the
software purchase date. After 1 year, users are urged to acquire the necessary Software
Assurance Plan to continue with product support and ongoing activations for reinstallations and
license transfers.

3. Enhancement Requests

RBTI will provide continued product enhancements for requested features for 1 YEAR from the
software purchase date. After 1 year, users are urged to acquire the necessary Software
Assurance Plan to continue with product support and ongoing activations for reinstallations and
license transfers.

4. Periodic Activations

RBTI will provide periodic product activations of license transfers and/or reinstallations for 1
YEAR from the R:BASE purchase date. Any activation requests that occur beyond the 1 Year
purchase date will require an active Software Assurance Plan.

NO OTHER WARRANTIES
Except as explicitly stated above, RBTI makes no express or implied warranties (including any warranties
of merchantability or fitness) with respect to the character, function, or capabilities of the program, the
documentation or their appropriateness for any user’s purposes. RBTI cannot customize product(s) to
meet specific needs in all cases. Examples of customization include, but are not limited to: special
character sets, foreign language adaptations, specific device drivers or other localization issues. Under
no circumstances will RBTI be held responsible for product functionality once alterations have been made
to accommodate individual needs.

http://www.rbase.com
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DISCLAIMER OF WARRANTY
The Program and the accompanying files are sold "as is" and without warranties as to performance or
merchantability or any other warranties whether expressed or implied. Because of the various hardware
and software environments into which the Program may be put, No warranty of fitness for a particular
purpose is offered. 

Good data processing procedure dictates that any program be thoroughly tested with non-critical data
before relying on it. The user must assume the entire risk of using the program. Any liability of the seller
will be limited exclusively to product replacement or refund of purchase price.

HIGH RISK ACTIVITIES
The Program is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-
line control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, air traffic control, aircraft navigation or communication systems, direct life
support machines, or weapons systems, in which the failure of the Program could lead directly to death,
personal injury, or severe physical or environmental damage ("High Risk Activities"). RBTI specifically
disclaims any expression or implied warranty of fitness for High Risk Activities. 

LIMITATIONS ON LIABILITIES
RBTI will not be responsible for any costs or damages associated with loss of the use of the Program or
any other resources, loss of business or profits, any loss of data, any third party claims or costs of
substitute programs. In no event will RBTI be liable for any incidental, indirect, special, consequential or
punitive damages suffered by the user or any other person or entity, whether from the use of the
program or documentation, any failure thereof, or otherwise, even if RBTI or its dealers or agents are
aware of the possibility of such damages. In no event will RBTI aggregate liability to you or anyone else
exceed two times the license fee you paid for the program and documentation in this package. Because
some states do not allow the limitation or exclusion of implied warranties and liabilities for consequential
or incidental damages, the above limitations may not apply to you.

GENERAL
This License Agreement constitutes the full and complete agreement between parties. RBTI retains all
rights not specifically granted herein. RBTI shall not be deemed to have waived any of its rights
hereunder or under all copyright laws, trade secrecy laws or otherwise. This Agreement is intended as a
legally binding agreement which will be enforced to the full extent permitted under applicable law, in
whole or in part. If any one provision of this Agreement is declared invalid or unenforceable, all
remaining provisions shall never less remain in effect. The laws of the state of Pennsylvania shall govern
this Agreement. RBTI reserves the right to amend, alter, or revoke this agreement at any time. All
revisions to this license agreement are available for inspection upon request, supersede conditions in all
past agreements, and render prior license agreements void and unenforceable. Both parties named in
this license will only be bound to the terms of the most current revision of this agreement.

U.S. GOVERNMENT RESTRICTED RIGHTS
Use, duplication or disclosure by the Government, its agents or employees is subject to all restrictions
imposed by law, regulation or government directive, including but not limited to those restrictions set
forth in DFARS 252.227-7013 and 48CFR 52.227-19, as applicable.

R:BASE Technologies. Inc. 
 3935 Old William Penn Highway 
 Murrysville, PA 15668-1854 
 (724) 733-0053 TEL 
 (724) 733-0196 FAX 
 URL...: http://www.rbase.com
 E-Mail: rbaseinfo@rbase.com

Copyright 1982-2021 R:BASE Technologies, Inc. 
All Rights Reserved
Revised Monday, April 5, 2021
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1.4 Complimentary Technical Support

30 DAY LIMITED COMPLIMENTARY 
TECHNICAL SUPPORT

 
A. LICENSEE RESPONSIBILITIES. 

1. To help us expedite the process and provide high quality assistance, the licensee must provide
proof of purchase when calling. Proof of purchase is defined as the following: INVOICE NUMBER,
PURCHASE DATE, VERSION AND BUILD NUMBER, SERIAL NUMBER, AND COMPANY OR INDIVIDUAL
TO WHICH  PRODUCT IS REGISTERED.

2. To have operating system, workstations, and  local network installed and functional. RBTI will NOT
be responsible for resolving issues not pertaining to the R:BASE program.

3. Our support staff deals with advanced issues, therefore the person contacting RBTI for assistance
should be the system administrator or have other R:BASE/SQL experience and be able to understand
and implement the advice given.

4. To have the database(s) being converted, safely backed-up before attempting conversion process.
RBTI will NOT be held responsible for lost data or corruption as a result of advice given.

5. Once converted, Licensee is responsible for updating command syntax in APPLICATIONS, altering
FORMS and REPORTS to accommodate the 4 digit year function, and other changes as necessary.

B. R:BASE TECHNOLOGIES, INC.  RESPONSIBILITIES.
1. To provide quality assistance in a timely manner to aid Licensee in the installation of the product
WITHIN 30 DAYS OF DATE OF PURCHASE.

2. To provide a reasonable solution for any resolvable issue. Not all issues are resolvable, and
therefore we will acknowledge the existence of known issues or "bugs" which we are presently aware
of, that have no reasonable work-around.

R:BASE Technologies, Inc. reserves the right to limit the amount of support time allotted to a maximum
of 2 HOURS during the 30 Day Complimentary Technical Support period. We also reserve the right to
limit the quantity of calls from a particular licensee to 30 MINUTES in a single day. Issues are dealt with
on a case by case basis, and therefore at the discretion of the support agent assigned to the case.

Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related issues
ONLY. Our support hours are from 10am. to 6pm. Eastern Time.

For assistance on your APPLICATIONS, DESIGN, OR ADVANCED CONVERSION issues, we offer
Technical Support Plans of various types to meet your needs. Please call us at 724-733-0053 or visit
Technical Support Plans for details and pricing.

http://www.rbase.com/support/plans.php
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2 Installation

2.1 System Requirements

The following system specifications are recommended for the optimal use of R:BASE and R:BASE-related
software. 

Workstation Hardware

· 2-Core 2GHz+ CPU
· 2 GB of available RAM (4 GB recommended)
· 2 GB of available hard disk space
· 1024x768 or higher resolution video adapter and display
· Standard mouse or compatible pointing device
· Standard keyboard

Server Hardware

· 2-Core 2GHz+ CPU
· 6 GB of available RAM (8 GB recommended)

Operating System

· Microsoft Windows 10 (Professional)
· Microsoft Windows 8 (Professional)
· Microsoft Windows 7
· Microsoft Windows Server 2019
· Microsoft Windows Server 2016
· Microsoft Windows Server 2012, 2012 R2
· Microsoft Windows Server 2008, 2008 R2

Network

· Ethernet infrastructure (Gigabit recommended)
· Internet connection recommended, but not required, for license activation, updating, & support
· Anti-virus programs should exclude the R:BASE program and database files
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3 Software Installation

The installation of R:Archive X.5 Enterprise is fully automated and does not require user intervention for
the initial setup. 

Run the installer ".exe", provided by download, while physically sitting at the workstation to begin the
installation process, and read the installer screens for licensing and other information as the program
installs.

Installation Directory   

C:\RBTI\RArchiveX5E

Files Installed

RArchive.rx1
RArchive.rx2
RArchive.rx3
RArchive.rx4
RArchive.dat
RBASE.dat
RArchiveX5.rbm
RArchiveX5E.chm
RArchiveX5E.pdf
RTwain2PDFX5.chm
License.rtf
Readme.txt
StartAllOver.rmd

 

Requirements:

Plugin
The R:Archive X.5 Plugin file (RArchiveX5.rbm) and help reference (RTwain2PDFX5.chm) must be
placed in the R:BASE X.5 Enterprise program directory or the runtime/compiled application
directory. 

R:BASE Version Default Program Directory

X.5 Enterprise (Version 10.5) C:\RBTI\RBGX5E

Desktop Shortcut
Create a desktop shortcut for the R:Archive program. For the desktop shortcut icon that will run this
application, a custom "Target:" and "Start in:" must be used as follows:

Target: C:\RBTI\RBGX5E\RBGX5E.exe RArchive.dat
Start in: C:\RBTI\RArchiveX5E

When launching the application, the log in prompt screen will be displayed. The following profile may be
used to access R:Archive:

Login: admin
Password: admin

To access the R:BASE development interface and Security table, the password is: RArchive
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4 Using R:Archive

4.1 Quick Start to Archiving

Here's the minimum info users need to set up R:Archive and begin scanning. First, launch R:Archive from
the desktop icon. For your appropriate Login and Password, contact your network database
administrator*. 

1. Apply Settings
From the R:Archive menus, choose "Set Default Scanner" from under "Scan and Index Documents".
 The R:Archive program will appear for users to set the default scanner for scanning documents.
Choose "File" > "Select Source..." from the Menu Bar to display a list of available sources. Select
your source, click the "Select" button and close the window.

2. Setup Session
Choose "Current Session Settings" from under "Scan and Index Documents". 

A. The default folder for scanned documents is the SCANS subdirectory within the R:Archive
installation directory (default: C:\RBTI\RArchiveX5E). 

B. Define the file prefix for all scanned documents. The default value is "RA_".
C. If users require the capturing of the scanned data, select OCR. 

For additional information on OCR or any other settings, visit Current Session Settings.

3. Start Scanning
Now, you can begin scanning your document. For this first scan, we'll use the "Scan Document
(Automatic)" menu option. The scanner software will launch your scanned document prompting you
to accept the scan. You may be force to preview the scan first.

4. Save Document Information
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After accepting the scanned document, a window will appear displaying the document identification
number, date, time, operator, and file path. The document Title and Notes can now be added for
additional document descriptions. The file can also be viewed by selecting the "View" button. Choose
"Done" when you are finished.

*All users will have full access until the administrator sets up user accounts. The Custom EEP
to prevent/allow users full access is located in the form "RArchiveLoginScn" within the
"Login" button.

4.2 Scan and Index Documents

4.2.1 Set Default Scanner

This menu option launches the R:Twain2PDF program interface and allows you to select one of your
available scanners or TWAIN devices. 

To choose a TWAIN source, users can perform either of the following options:

· select the "Select Source..." button   from the Tool Bar
· choose "File" > "Select Source..." from the Menu Bar

The following dialog will be displayed with a list of TWAIN sources.

4.2.2 Current Session Settings

This menu option defines the folder on a computer where scanned documents will reside, the file prefix
for all scanned documents, and any OCR settings, if defined.

Session Folder:
Displays the current session folder location. To create or change the session folder, choose the "Change
Folder" button. A menu will launch allowing users to select a folder location on a computer. Select the
"Done" button when finished.

File Prefix:
Displays the file prefix for scanned documents. The default file prefix is "RA_". To alter the file prefix,
type over the existing value. Select the "Done" button when finished.



Using R:Archive 15

Copyright © 1982-2021 R:BASE Technologies, Inc.

4.2.3 Scan Document (Automatic)

The "Scan Document (Automatic)" menu option will launch a scanner and begin scanning documents. The
Scan File Details dialog will open displaying the Document ID, Date, Time, Operator, and File Path. 
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The scanned document "Title" and "Notes" fields are editable for users to add information. The scanned
document can be viewed by selecting the "View" button.

4.2.4 Scan Document (Manual)

The "Scan Document (Manual)" menu option will launch a scanner software for users to begin scanning
documents. The available options would be subjected to the software provided with a scanner. 
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The Scan File Details dialog will open displaying the Document ID, Date, Time, Operator, and File Path. 
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The scanned document "Title" and "Notes" fields are editable for users to personally add information. The
scanned document can be viewed by selecting the "View" button.

4.2.5 View Scanned Documents

The "View Scanned Documents" option will open a dialog window displaying a list of scanned documents.
For each selected scanned document within the left panel, the scanned image will appear on the right
panel. The buttons across the bottom allow users to move easily throughout all the scanned documents.
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4.3 Manually Index Documents

4.3.1 Select and Index PDF Document(s) - One

The "Select and Index PDF Document(s) - One" menu option allows users to search a computer for a
single PDF file to index with the R:Archive. This allows users to store a document ID, date and time,
operator, file location, title, subject, author, keywords, creator, producer, and notes for the PDF file.
Storing this information in R:Archive allows users to perform a more accurate file search on a computer
for future references. 

The buttons across the bottom allow users move from file to file, when more PDF files are selected, as
well as view the PDF document.
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The indexed document can be viewed by selecting the "View" button.

4.3.2 Select and Index PDF Document(s) - Multiple

The "Select and Index PDF Document(s) - Multiple" menu option allows users to search a computer for a
multiple PDF files to index with the R:Archive. This allows  users to store a document ID, date and time,
operator, file location, title, subject, author, keywords, creator, producer, and notes for the PDF files.
Storing this information in R:Archive allows users to perform a more accurate file search on a computer
for future references. 

The buttons across the bottom allow users move from file to file, as well as view the PDF document.
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The indexed documents can be viewed by selecting the "View" button.

4.3.3 View PDF Document(s)

The "View PDF Document(s)" menu options displays the list of indexed PDF documents stored within
R:Archive. This window displays the document ID, date, time, user, and name, and viewer of the PDF
document. Based on a user's PDF Reader settings, the viewer may display the PDF document differently.
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4.4 Search Documents

4.4.1 Search Scanned Documents

The "Search Scanned Documents" menu option allows users to search for scanned documents within
R:Archive. The search criteria options include "Document Date", "Document Operator", and "Document
Title". 

When the document search returns a list of documents, the "View Scanned Files" window will display the
list of scanned documents, which match the search criteria.
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4.4.2 Search PDF Documents

The "Search PDF Documents" menu option allows users to search for indexed PDF documents within
R:Archive. The search criteria options include "Document Date", "Document Operator", and "Document
Title", "Document Subject", "Document Author", and "Document Keywords". 
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When the document search returns a list of documents, the "View PDF Scanned/Indexed Files" window
will display the list of scanned and or indexed PDF documents, which match the search criteria.

4.5 PRINT Catalog

4.5.1 Print Scanned Documents Catalog

The "Print Scanned Documents Catalog" will print a report to the screen displaying a Master File Catalog
of scanned documents. 
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4.5.2 Print PDF Documents Catalog

The "Print PDF Documents Catalog" will print a report to the screen displaying a Master PDF Documents
Catalog of PDF documents. 
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4.6 System Reports

4.6.1 Document Session Log

The "Document Session Log" menu option will display the R:Archive Document Session Log. 

4.7 Database Maintenance

4.7.1 Review User Access Table

The "Review User Access Table" menu option will display the "User Access Table" information. The
window displays the User ID, User Login, Password, and User Group of the users. The default password is
"RArchive".
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4.7.2 Review Session Log Table

The "Review Session Log Table" menu option launches the complete R:Archive Document Session Log.
The window displays the date, time, operator, session folder, and file prefix.
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4.7.3 Table Analysis

The "Table Analysis" menu option will allow users to choose and analyze any of the available R:BASE
tables in R:Archive.  First, choose a table from the list to analyze.
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Then, R:Archive will analyze and display the table information. The "Utilization" should be higher than
50%. Otherwise, it is recommended that users Pack the table. 

4.7.4 Pack Table

The "Pack Table" menu option will allow users to pack (or compress) any of the available R:BASE tables
in R:Archive. First, choose a table from the list to pack.

Then, R:Archive will compress the table and display a completion message.

4.7.5 Pack Indexes

The "Pack Indexes" menu option will allow users to pack (or compress) the R:BASE table indexes within
R:Archive. This allows for faster processing when searching for documents.

4.7.6 Backup Entire Database

The "Backup Entire Database" menu option will backup the database structure and data. First, users will
be prompted to select a folder to place the backup files.

After the backup is complete, a message will be displayed with a confirmation. Two files will be placed in
the specified folder with the naming convention including the date and time of the backup.
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4.8 Help

The "Help" menu option displays the R:Archive in-line help documentation.

4.9 About R:Archive

The "About R:Archive" will display current information about the product such as the version of
R:Archive, the version and build of R:BASE, contact, and license information.

4.10 Exit

4.10.1 Exit R:Archive

The "Exit R:Archive" menu option closes R:Archive and returns users to the operating system.

4.10.2 Switch to R> Prompt

The "Switch to R> Prompt" menu option will close R:Archive and drop users to the R:BASE development
level.

For the password, refer to the ReadMe.TXT file.
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5 Technical Support

Please read over this inline HELP documentation at least once before seeking support for this product. We
have worked very hard to make this help file clear and useful, but concise. There's a lot of power here so
we suggest you reread these instructions once you have become accustomed to using R:Archive. New
uses will become apparent. 

If you have further question(s) about R:Archive, and can't find the answer(s) in this help documentation,
you can obtain information from a variety of sources: 

· E-mail our Technical Support Department at: support@rbase.com  
· Access the R:BASE Technologies Support Home Page on the World Wide Web at

http://www.rbase.com/support.  
· Call our Technical Support Department at (724) 733-0053 Monday through Friday, 10:00 AM to 6:00

PM (EST). You should be at your computer with R:Archive running and ready to make changes
suggested by our technical staff. You may be required to purchase a technical support plan. Several
support plans are available to suit the needs of all users. Available Technical Support Plans

Please be prepared to refer to the following: 

· The technical support registration number, which is located on the registration card included with this
product. If you purchased this product directly from R:BASE Technologies, your technical support
registration number can be found on your invoice or packing sheet.  

· The type of hardware and operating system you are using.  
· Details regarding your operating environment, such as available memory, disk space, your version of

R:Archive, local area network, special drivers, related database structures, application files, and other
files that are used or accessed by your application.  

All of the information that you provide us is used to better and more expeditiously assist you. 

R:BASE Technologies has a number of different services available for R:BASE products. As a registered
user, you will receive information about new releases of R:Archive and other R:BASE Technologies
products. Please remember to register your R:BASE software as well as any other R:BASE related
software. http://www.rbase.com/register/ 

mailto:support@rbase.com
http://www.rbase.com/support
http://www.rbase.com/support/plans.php
http://www.rbase.com/register/
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6 Feedback

Suggestions and Enhancement Requests:

From time to time, everyone comes up with an idea for something they'd like their software to do
differently. 

If you come across an idea that you think might make a nice enhancement, your input is always
welcome. 

Please submit your suggestion and/or enhancement request to the R:BASE Developers' Corner Crew
(R:DCC) and describe what you think might make a nice enhancement. In R:BASE, the R:DCC Client is
fully integrated to communicate with the R:BASE development team. From the main Menu Bar, choose
"Help" > "R:DCC Client". If you do not have a login profile, select "New User" to create one.

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the request. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted enhancement request. 

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

Reporting Bugs:

If you experience something you think might be a bug, please report it to the R:BASE Developers'
Corner Crew. In R:BASE, the R:DCC Client is fully integrated to communicate with the R:BASE
development team. From the main Menu Bar, choose "Help" > "R:DCC Client". If you do not have a login
profile, select "New User" to create one.

You will need to describe: 

· What you did, what happened, and what you expected to happen
· The product version and build 
· Any error messages displayed
· What computer operating system is in use 
· Anything else you think might be relevant 

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the bug report. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted bug.

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

mailto:rdcc@rbase.com
mailto:rdcc@rbase.com
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7 Useful Resources

. R:BASE Home Page: http://www.rbase.com

. Up-to-Date R:BASE Updates: https://www.rbaseupdates.com/

. Current Product Details and Documentation: http://www.rbase.com/rbgx/

. Support Home Page: http://www.rbase.com/support/

. Product Registration: http://www.rbase.com/register/

. Official R:BASE Facebook Page: http://www.facebook.com/rbase/

. Sample Applications: http://www.razzak.com/sampleapplications

. Technical Documents (From the Edge): http://www.razzak.com/fte

. Education and Training: http://www.rbase.com/training

. Product News: http://www.rbase.com/news

. Upcoming Events: http://www.rbase.com/events

. R:BASE Online Help Manual: http://www.rbase.com/support/rsyntax

. Form Properties Documentation: http://www.rbase.com/support/FormProperties.pdf

. R:BASE Beginners Tutorial: http://www.rbase.com/support/rtutorial

. R:BASE Solutions (Vertical Market Applications): http://www.rbase.com/products/rbasesolutions/

http://www.rbase.com
https://www.rbaseupdates.com/
http://www.rbase.com/rbgx/
http://www.rbase.com/support/
http://www.rbase.com/register/
http://www.facebook.com/rbase/
http://www.razzak.com/sampleapplications
http://www.razzak.com/fte
http://www.rbase.com/training
http://www.rbase.com/news
http://www.rbase.com/events
http://www.rbase.com/support/rsyntax
http://www.rbase.com/support/FormProperties.pdf
http://www.rbase.com/support/rtutorial
http://www.rbase.com/products/rbasesolutions/
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